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INTRODUCTION
SYSTEM REQUIREMENTS

Rockford! requires a 386/486 CPU, Windows 3.1, a hard disk and mouse, plus a 
minimum of 2 MB of RAM and 2 MB of hard disk space, VGA or better graphics and a 
Windows compatible graphics printer. If you use Print Manager, you'll also need about 4 
MB of free disk space on the disk where you store .TMP files for Temporary files. This 
program supports only TrueType and Adobe Type Manager fonts. HP DeskJet users: 
Rockford! supports all models of these printers.  See the section on HP DeskJet printers 
near the end of this manual.

Rockford! 4.0 includes a number of new features, in addition to the many 
powerful features included in earlier versions. Whether you've used a previous version, or
are using Rockford! for the first time, please read this manual thoroughly. It'll save you a 
lot of time and help you use the program better.

LICENSE INFORMATION
Thank you for trying Rockford! and for using shareware. Shareware is 
an excellent way for you to test new programs without paying for them
in advance. However, shareware software is not free. After testing the 
program, you're required to pay for it and register if you continue to 
use it. By paying for the shareware programs you use, you help keep 
this company and other companies alive and creating software you can
try before you buy. Please register all shareware programs you use 
regularly!

This is the UNREGISTERED version of Rockford! 4.0. Rockford! is a 
shareware program. You may try this copy of the program for a period 
not to exceed 30 days to determine whether or not it is suitable for 
your needs. After that time, if you continue to use the program, you 
must register your copy with the author. To register, use the OsoSoft 
Program Info command in the Help Menu to print the registration form. 
The
Registration fee for this program is $20.

You can also register with a Visa or MasterCard by calling OsoSoft at 
(805) 528-1759
during normal West Coast business hours. OsoSoft programs may also 



be registered on CompuServe in the SWREG forum. Registrations will 
be charged to your CompuServe account.

Registered users receive the very latest version of the program, a 
printed manual,
automatic notification of major upgrades, and support. In addition, 
when you register,
you'll always be entitled to upgrade to new registered versions at no 
charge on the
OsoSoft BBS at (805) 528-3753. Registered users are entitled to 
unlimited free support
by telephone, fax, on the OsoSoft BBS, and on CompuServe. Registered
users will also receive a offer for a Free Introductory Membership on 
CompuServe, where you can access the OsoSoft section with the 
command: GO OSOSOFT

Unregistered users receive only a minimum of support, limited 
to some installation
support., but are not entitled to telephone support. If you call 
the OsoSoft voice number for support as an unregistered user, 
you will be asked to register at that
time by credit card.

Users of this program, along with traditional shareware distributors 
may distribute
copies of  the shareware versions of this program, but only under the 
terms described
in the VENDOR.DOC file included with this copy of the program. All 
commercial
distributors MUST read that file and abide by the distribution rules 
contained in that
file. Violations of the distribution license in VENDOR.DOC may result 
in prosecution
under appropriate copyright laws of the United States and other 
countries.

Rockford! and all related files, including this documentation are 
Copyright 1991,1995
by OsoSoft. All rights are reserved.

OsoSoft is a member of the Association of Shareware Professionals and
the Software
Publishers' Association.

OsoSoft
1472 Sixth Street



Los Osos, CA  93402
OsoSoft BBS: (805) 528-3753
Voice Order Line: (805) 528-1759
CompuServe ID: 74774,442 or GO OSOSOFT

HOURS
OsoSoft business hours are 7 AM to 4 PM, Pacific Time, on weekdays. 
Calls outside
those hours are not appreciated.

ASP OMBUDSMAN NOTICE
This program is produced by a member of the Association of Shareware
Professionals
(ASP). ASP wants to make sure that the shareware principle works for 
you. If you are
unable to resolve a shareware-related problem with an ASP member by
contacting that
member directly, ASP may be able to help. The ASP Ombudsman can 
help you resolve
a dispute or problem with an ASP member, but does not provide 
technical support for
members' products. Please write to the ASP Ombudsman at 545 Grover
Road,
Muskegon, MI 49422-9427 USA FAX 619-788-2765 or send a 
CompuServe message
via CompuServe mail to ASP Ombudsman 70007,3536.

Rockford! 's Features
Use any TrueType or Adobe Type Manager Font
Insert up to Two BMP,  or PCX Clip Art Images
Draw Lines, Boxes and Circles
Use Any Pre-Scored Card Stock From Any Supplier or Plain Card Stock
Create Camera-Ready Layouts at 200% Size
Create 4-Up Camera Ready Layouts
Create Vertical or Horizontal Card Layouts
Works with Any Windows-Compatible Printer
WYSIWYG Display
Full Support for Color Printers
Rotate Text
Insert Foreign or Symbolic Characters Quickly
Overlay Text on Graphics
Filled Boxes and Circles with Text Overlays
Enter Dimensions in Any Measurement System
Right-Click Help



New Features in Version 4.0
Click and Drag to Position Text Instantly
Use Custom Colors for Text and Line Art
Now supports WMF Clip Art files
Undo for Most Commands
Custom Card and Card Stock Sizes (European Too)
Transparent Screen Graphics Show Underlying Text
Improved Printing Speed and Error Handling

VBRUN300.DLL REQUIRED
The shareware and online update versions also require 

VBRUN300.DLL, which must be installed in the WINDOWS\SYSTEM 
directory. If you do not have a copy of that file, you may download it as
VBRUN300.ZIP from the OsoSoft BBS at (805) 528-
3753, or obtain it from the source where you got your copy of the 
shareware version.

INSTALLATION
NOTE: If you are installing this program as part of OsoSuite 1.1, skip
these installation instructions. The program was installed correctly 
when you used the instructions in OSOSUITE.WRI. If you did not install 
using those instructions, please read OSOSUITE.WRI before installation.

The Shareware version of Rockford! uses a manual installation 
technique. The Full Registered Version includes an automated 
installation program. To install this program, take the following steps. If
you need help with any of the file and directory procedures, consult 
your Windows or DOS Manual.

1. Copy all files from the distribution diskette or the ZIP file containing 
the program
into a directory on your hard disk. OsoSoft recommends that you 
create a directory
called ROCKFORD for the files. 

2. Now,  if you choose, copy all files with the extensions .DLL and .VBX 
from the ROCKFORD directory into your WINDOWS\SYSTEM directory. If 
you'd rather, you may leave these files in your Rockford! directory and 
skip to Step 3. If you're working from the DOS prompt while in the 
ROCKFORD directory, the commands would be:

COPY *.DLL C:\WINDOWS\SYSTEM



COPY *.VBX C:\WINDOWS\SYSTEM

Naturally, you'd substitute your own drive and directory information if 
you installed
Windows in a different directory.

NOTE: Once you have successfully copied all DLL and VBX files into the
WINDOWS\SYSTEM directory, you may delete them from the Rockford! 
home
directory, if desired, to save disk space. Do not, however, delete any 
other files.

You must also have a copy of VBRUN300.DLL in your WINDOWS\
SYSTEM
directory. See the note above if you do not have a copy of that file.

3. If Windows is not running, start it. Then, from the Program Manager, 
click once
inside the program group where you want the Rockford! icon. Then, 
select the New
command from the Program Manager's File menu. Make certain the 
Program Item
option is selected, then click OK or press <Enter>.

4. In the Description field of the resulting dialog box, type Rockford!, 
then press
<Tab>.

5. In the Command Line field, type C:ROCKFORD\ROCKFORD.EXE, 
substituting other drive and directory information, if necessary. Press 
<Tab>.

6. In the Working Directory field, type C:\ROCKFORD, or substitute 
other drive and
path information, if necessary.

7. Press <Enter> or click OK to complete the installation. The 
Rockford! icon will
appear in the program group you selected earlier.

Note for International Users
Due to a flaw in Windows 3.x, you must use U.S. style numerical notation when 

using Rockford! . Otherwise dimensions will be lost when card files are saved, then 
reloaded. To change to this notation, double-click the International icon in the Windows 
Control Panel, click the Number Format button, then change your settings to use a 
comma (,) as a thousands separator and a period (.) as a decimal separator.



Uninstalling Rockford!
If you ever need to uninstall Rockford! , simply delete all files from the directory 

in which you installed the program, then remove the directory. You can do this using File 
Manager. During installation, Rockford! you may have also installed several DLL and 
VBX files in your Windows\System directory. Since these file may also be used by other
programs, it is recommended that you do not delete these files. If you wish to delete 
them, you'll find a complete list of files installed by Rockford! in the FILES.TXT file on 
your installation disk. However, delete them with caution to prevent problems with other 
programs which may also use these files.

USING ROCKFORD!
To run Rockford! , start Windows, then double click on the Rockford! icon in the 

Program Manager. A notice will appear on your screen as the program loads and creates 
its font list. If you have a large font library, this may take up to a minute. On subsequent 
program loading, the program will load the font list from its own file.  You'll also have a 
chance the first time the program loads to create a customized heading text for camera-
ready layouts. Use this text to advertise your business.

Next, you'll see the Rockford! main screen. Unlike many other Windows 
programs, Rockford! uses command buttons and drop-down list boxes, rather than menus,
to perform many functions. Most commands you need to create card designs are right on 
the screen, grouped according to function. Traditional Windows menus offer other 
commands. As with most Windows programs, shortcut keys are available for most 
functions.
RIGHT-CLICK HELP TIP: Whenever you wonder what a button or command does in 
Rockford! , just right click on the button. A help line will appear in the Rockford! title 
bar.

EDITING AND DISPLAY WINDOWS
You'll see two windows on the screen. At the top is the text-editing window. Here, you'll 
enter and edit all the text to be included on your card. Just below it is another window, 
where a WYSIWYG display of your card appears. You can't edit directly in this window, 
although many functions operate by clicking in this window.

Editing Text in Rockford! 
Rockford! ''s text box works much like your Windows word processing program. 

You can simply type your text in the box, pressing <Enter> to move to a new line. To 
position the cursor in your text, use the cursor keys or click the mouse pointer where you 
want to type. If you select text by dragging with the mouse, new text you type replaces 
the selected text. The WYSIWYG display updates when you press <Enter> or perform 
any formatting command. When you're entering text, all attributes continue from line to 
line when you press the <Enter> key. When you delete lines, remaining text maintains its
formatting. You are limited to 80 lines of text in Rockford! .

NOTE: It's very important to remember that Rockford! depends on the selected text line 



for all formatting. Before performing any formatting operation, select the line of text you 
want to format, by positioning the cursor on that line in the text window.

TUTORIAL 

YOUR FIRST SHEET OF CARDS
Getting to know any program takes some time, plus careful reading of the manual.

However, to speed up your introduction to Rockford! , here's a guide to producing your 
first sheet of business cards. Just start Rockford! , then follow the steps below to create 
your first set of professional cards in minutes.

This brief tutorial will help you understand the principles of using Rockford! . The
program can do much, much more than produce simple cards, though. Read the rest of 
this manual to discover Rockford! 's other features and experiment with them until you're 
comfortable using them on actual cards.
1. In the Layout menu, choose a Horizontal or Vertical Card Format option which 
matches the card stock you have. If you're using pre-scored card stock, choose a format 
which matches that stock. The default format is a horizontal card to be printed on plain 
card stock, with cut marks printed. If you want something different, be sure to select the 
format you will actually use.

2. If you're using a pre-printed card stock, use the Margins command in the Layout 
Menu to adjust the top and left margins to compensate for any pre-printed area on your 
stock.

3. Choose a font and font size for the first line of your cards, using the drop-down lists at 
the right of your screen.

4. Type in your name, or the first line of your card. Don't press <Enter> yet.

5. Choose an alignment for your text in the drop down list at the right of your screen. 
Left aligned is the default. TIP: If you want all the lines of your card to be aligned

the same way, click the Layout menu and choose one of the alignment options there.

6. Press <Enter>, then type the next line for your card. Notice that your text appears in 
the WYSIWYG window, aligned just the way you chose. As long as you don't make any 
formatting changes, each line will have the same formatting as the first line.

7. Continue typing lines of text for your card until you've entered all your text. You don't 
have to press <Enter> after the last line to see that line on the screen. Click the [Update] 
button.

8. Now that all your text is entered, you can make layout changes. Start by making the 
first line a little larger than the others. To do this, click with the mouse on the first line in 
the Text Box at the top of the screen. Then, drop down the Font Size list on the right and 
click on a larger font size. The WYSIWYG screen will update instantly.



9. Now, let's add boldfacing to the first line. Since the cursor's already on that line, just 
click the Bold checkbox on the top right section of the screen. Check the WYSIWYG 
window.

10. These changes may have caused the last line of your card to run off the window. 
Move the cursor to the second line in the Text Box, and reduce the font size slightly. To 
make the remaining lines the same, move the cursor down to each line, then click the 
[Dupe Prev] button.

NOTE: All formatting commands operate on the line where the text box cursor is 
located.
If you want to place some text on both sides of the lower section of the card, as for 
address and telephone number blocks, type both items on one line, placing a tilde (~) at 
the point you want to split the line. Then, select the Split at Tilde alignment option from 
the alignment list. The line will automatically split, with half on one side of the card and 
half on the other side.

11. If you'd like to add a graphic image to your card, click the [AddArt] button and select
a graphic file from the list, then click OK. The image will appear on the left side of your 
card. You can use up to two images per card.

12. If the image is too large, use the [Scale] Scroll Bar in the Clip Art section of the 
commands on the right to decrease its size.

13. To move an graphic, make sure that the Pic 1 or Pic 2 option button is marked, then 
left-click in the WYSIWYG window, outside of the graphic. Hold down the button to 
drag the image around until it's where you want.

14. With an image on your card, you may want to switch text to be Right Aligned. Use 
the Layout menu to apply this formatting to the entire card quickly.

15. To position text in a particular position, select the line in the text box, then click the 
Click to Move Text check box. Now, click in the WYSIWYG window then drag the text 
to the location where you want it to appear.

16. If you want to add a line, box or circle to your card, click the appropriate item on the 
bottom right of your screen. Choose a color, if desired, plus a line width if you want 
something other than a thin line, then click the [Draw] check box. Now left-click in the 
WYSIWYG window where you want the object's upper left corner and drag the object to 
size. When you release the mouse button, the object will appear. 

17. When your card looks just the way you want, click the File menu, then click Print 
Single Test Card. Don't put card stock in your printer yet, though. Print your test on 
plain paper. Once the page emerges from the printer, hold it up behind a sheet of the cards
you'll use and check the alignment. If it's not perfect, use the Fudge Factors command in
the Layout menu to shift printing, and test again. Once everything's perfect, save your 



fudge settings as defaults. You won't have to set them again, in most cases.

18. Finally, insert a sheet or sheets of card stock in your printer and select the Print 
Sheets of Cards command in the File Menu to print out your business cards.

COMMAND REFERENCE
LEFT SIDE COMMAND BUTTONS

The Text Group
[Edit]—This button returns the cursor to the text editing box. Since Rockford! normally 
returns control to this box, you'll rarely, if ever, have to click this button.

[Click to Move Text]—This command lets you move text instantly to any position. To 
use this check box, position your cursor in the text box on the line of text you want to 
move. Then click this command. Now, click in the WYSIWYG display and drag the 
resulting box to the location where you want the text to appear. NOTE: with some line 
formats, like rotated text, the box will not reflect the actual angle or size of the text, but 
the upper left corner will be accurately positioned. Also, you cannot click inside a graphic
image to move text, although you can later drag the text over the image.

[TextColor]—Rockford! 4.0 can now print text in color on color printers. To choose a 
color, first place your text box cursor on the line you want to change. Then click a color 
bar.

[Custom]—Click this button to use the Windows standard custom color dialog box, 
choose one of the color selections or click Define Custom Colors to create a new color. 
Depending on your monitor setup, custom colors may not appear on the screen exactly as 
they will print. Experiment with sample printouts to get just the color you want.

NOTE: On most non-color printers colored text will print as a shade of gray. If colors all 
print as black, try changing your Printer Setup by marking the Print TrueType Fonts as 
Graphics.

The Card Group
[Update]—This button updates the WYSIWYG display. To improve performance, some 
commands used in Rockford! do not automatically update this display. If you carry out a 
command and the screen does not update properly, simply click this button.

[Clear]—This button clears your current card from the screen and from memory. You'll 
be asked to confirm this command in a dialog box. 

[Grid}—This button overlays a grid on the WYSIWYG display, to help you position text
and graphics. The grid has divisions of .1-inch, with full inch lines in bold. Click the 
button again to remove the grid. Use this feature with clip art and when using custom 
alignment.



[Print Sheet]—Use this command to instantly a sheet of cards. It's the same as the Print 
Sheet command in the File Menu.

[Print One]—This command prints a single test card for layout checking.

RIGHT SIDE COMMANDS

Text Attributes (Whole Line)
[Line]—Displays the current line number, as determined by the position of your cursor in
the text editing box.

[Dupe Previous]—This button allows you to repeat the formatting of the line above the 
current line. This is useful whenever you want duplicate formats on several lines. Just 
format any line, then move to the next line and click this button. All line formatting 
attributes will be duplicated. When typing, pressing <Enter> automatically copies the 
previous line's formatting.

[Font]—This drop-down list box displays the current font, and allows you to change a 
line to another font. Click on the arrow to drop down the font selection list. Scroll 
through the list, then click on your font selection.  

[Size]—Displays the current size for the text on the current line. Click the arrow to drop 
down a list of available font sizes for the line. Sizes range from 4 to 72 points, in one-
point intervals for the smaller fonts. HINT: Changing the font size of a blank line affects 
line spacing. Use this trick to adjust line spacing in 1-point intervals.

NOTE: Due to the way Windows operates, TrueType fonts smaller than 8.75 points may 
display in a different font and show incorrect spacing. These fonts, however, will print in 
the correct font and size. Use a sample printout for testing.

[Align]—This control affects the alignment of the selected line. To change, click the 
arrow, then select your option. You can choose left or right aligned, centered, split lines, 
or set a customized horizontal and vertical position. HINT: When using customized line 
positions, apply these to lines at the bottom of the card's text to avoid later misalignments
in normal lines.

NOTE: For split lines, insert a tilde (~) in the text box where you want the line to split. 
Rockford! will automatically separate the two halves of the line. You cannot insert 
internal formatting codes in split lines. Lines are split with the left half aligned with the 
left
margin and the right half aligned with the right margin. 

[Style]—Four check boxes control text attributes for the entire line.  You can select more 
than one style for any line. Clicking [Normal] removes all other style settings.



[Rev.]—This option prints the current line in white type on a black background. You 
cannot use this option on split  or rotated lines or when using inserted formatting 
commands. You can, however use any of the other text attributes with this feature. 
NOTE: Print a test card to make sure you're getting what you want.

[Rotate]—Rockford! now lets you rotate text up to 90 degrees in either direction. Start by
selected the line to rotate, as you normally do, then click this button. Use the scroll bars 
in the dialog box that appears to set a rotation angle, then click [Accept] to apply the 
rotation. You can also click [No Change] to keep the current rotation or [Default] to 
return to normal alignment. TIP: Combine rotation with the [Click to Move Text] feature
to position rotated text wherever you want it.

The Clip Art Group
[AddArt]—Opens a dialog box for loading .BMP, .WMF or .PCX clip art images. 
Rockford! supports black and white or color images up to 256 colors. To see a preview of 
an image, click once on the filename. To load the image, double-click the file or click 
OK. Rockford! will automatically select either the first or second clip art image, and 
position it in the WYSIWYG display. TIP: If your desired clip art image appears much 
too large or small, edit it in a graphics program to make it approximately the correct size 
before importing it into your card. 

[HideArt]—A new command, this button temporarily removes all clip art and line 
drawing art from the WYSIWYG display. Since Rockford! can overlay text on a graphic 
or line art object, use this command to help you see text position better if it is obscured 
by a clip art image. When clip art is hidden, a dotted box shows its location for alignment
purposes. When you click this command, its caption changes to [ShowArt]. Clicking it 
again will redisplay your graphics.

[Delete]—Removes the currently-selected clip art image. 

[Option Buttons]—Selects one of the two clip art images. You may select by clicking the
button, or by double-clicking on the image itself. You must select an image before acting 
on it. Options are PIC 1 and PIC 2. Normally, PIC 1 is on the left side of the card, and 
PIC 2 is on the right side of the card. When selected, a thin border will appear around the
image.

[Scale]—Use this control to resize a selected clip art image. Remember, the command 
only affects the image selected with the option buttons. For small changes, click the 
arrows. Click between the arrows for larger changes. The image always stays in 
proportion.  You can scale images between 10% to 500% of the original size.

HINT: Avoid major changes in clip art image size, to avoid image degradation. If you 
need to enlarge or reduce an image very much, do so in a paint program like Windows 
Paintbrush before loading it into Rockford! . This will result in an improved appearance 
on your card, since paint programs have sophisticated scaling routines.
Also, very large images scaled to fit a card may create a temporary file when printed that 



is too large for your free disk space. Again, scale your images outside of the program. To 
help you with that, you can edit the currently selected image with the Edit Image 
command in the Edit menu. If you do this, after editing the image, delete the current 
image, then reload the new version from disk with the [AddArt] button.

Moving a Clip Art Image
You can move a clip art image by dragging it around the screen with the mouse. To do 
this, first select the image you want to move by clicking the appropriate option button in 
the Clip Art Group, or by double-clicking on the image itself. When the image is 
selected, a thin border appears around the image. With the image selected, click the left 
mouse button somewhere outside of the image. The image will instantly move, with its 
upper, left corner at the position where you clicked. Then, with the mouse button held 
down, you can drag the image to a new location. The new location is stored with the card 
when you save. If you try to drag the image by first clicking on the image, a message will
appear telling you to click outside the image. For precise positioning, try turning on the 
[Grid] display before positioning the image.

Where Clip Art Files Are Stored
Rockford! doesn't store the actual graphical image in its .CAR files. Instead, it stores the 
name and location of the file containing that image. If you move the image or delete it, 
Rockford! will not be able to find it later when you reload the .CAR file. If this occurs, 
the program will warn you, and you'll have to reload the image with the AddArt button.

The Line Drawing Group
[Object]—This drop-down list box allows you to select an individual object for editing.  
If you do line drawings, each line, box, or circle gets an object number, which appears 
near the object. Select the object you want to modify in this list box.

[Width]—This box controls the width of line drawing elements. Widths range from 1 to 
24 pixels on the screen, which translates roughly to point measurements on the printer. If 
you change the current setting, it will affect the current object, if present, or the next 
object you draw.

[Draw]—This check box enables line drawing. Click it before creating an object. 
Rockford! will automatically select the first available object number.

[Filled]—This check box appears only when you've drawn or selected a box or circle. If 
you check it, the box or circle will be filled with the same color used to draw the box. 
Uncheck it to remove the fill.  NOTE: Some printers always draw a solid black box 
around the object. This can't be prevented, so test your work by printing a sample card. 
TIP: Rockford! can print text inside filled boxes. Use this technique to create boxes filled
with one color, then use a contrasting color for the text. On black and white printers, 
you'll have to experiment to get just the right effect. Also, remember that you can position
text with the [Click to Move Text] command.

[Line], [Box], [Circle]—These options determine the type of object you want to draw.



[LineColor]—This set of color bars lets you set the line and fill color for either a new 
object or for an existing object picked from the object list. Select the object, then apply a 
color. The same color is used for both the lines and fill. 

[Custom]—As with text, you can apply custom colors to your lines, using this command 
to call the Windows Custom Color dialog box.

DRAWING AN OBJECT
To draw an object in the WYSIWYG screen, first select the type of object ([Line] [Box] 
[Circle]), then set the width for the lines used to draw the object, and the color for that 
object. Next click on the [Draw] checkbox. Move the mouse pointer inside the 
WYSIWYG display. While holding the left button down, drag the mouse pointer to a new
location. A rubber-band image of your object will appear as you draw. Draw slowly for 
best results. When the object is approximately the right size, release the left mouse button
to place your object on the screen. A number will appear next to the object to identify it. 
You can move or size any object later.

NOTE: Rockford! does not check to make sure your object is within the boundaries of 
the card. That's your responsibility. Objects extending past the card's edges WILL print 
outside the card's boundaries.

TIP: Rockford! automatically converts all lines drawn at small angles to either horizontal 
or vertical straight lines. Lines drawn at other angles will maintain their angle.

[Move], [Size] Options—These two options determine whether the scroll bars (see 
below) move or size the current object.

[Scroll Bars]—Horizontal and vertical scroll bars control positioning of graphical 
elements. Depending on which of the option buttons above is selected, you can move or 
scale all graphical objects in .005 inch increments. 

MOVING AN OBJECT 
Start by selecting the object in the [Object] list box. Next, click on the [Move] option 
button. To move the object in .005" increments, click on the [Up], [Down], [Left], or 
[Right] arrows on the appropriate scroll bar. To move the object in .05" increments, click 
the scroll bar regions between the arrows and the position button on the scroll bar. To 
move the object in larger increments, click and drag the thumb on either scroll bar.

SCALING A LINE DRAWING OBJECT
First, select the object you want to resize, then click the [Size] option button. Then use 
the scroll bars as described above to alter the size of the object. 
Erasing and Restoring Line Drawing Objects

[Erase Selected]—This button erases the current image, as identified in the [Object] list 
box. This erasure is permanent. 



[Erase All]—This button removes all graphical elements from the screen. 

MENU COMMANDS

FILE MENU
New Card Design—Clears the current card and sets up for a new design. If a card is 
already on the screen, you'll be prompted to clear it or abort.

Open Card File—Opens an existing .CAR card design file. For simplicity, store your 
cards in the Rockford! home directory.

Save Current Card—Saves the current card with the current filename. The current file 
will be overwritten without warning. If you're making a different card, use the Save As... 
command.

Save Current Card As...—Lets you save the current design under a different filename.

Print Sheet(s) of Cards—This command prints your current cards on the selected card 
stock.  You'll get a full sheet of identical cards or a sheet of cards with different text if 
you're using the Merge commands.

Print Single Test Card—This command prints a single card on plain paper. The card 
will appear in the top left card position for your card stock. Use this command for fast 
checking of your design as it will appear when printed, and to test alignment on your 
printer.

Multiple Copies—In most cases, you'll be asked how many copies you want to print. If 
your printer, like most laser printers,  supports internal multiple copies, printing goes 
much faster if you select the number of copies here. If your printer does not support this 
feature, which is common for dot-matrix and inkjet printers, Rockford! will still print 
multiple sheets, although the process will take longer since the program actually executes
the print command as many times as you specify.

Print Color Sample—Every printer handles color differently. Use this command to print 
samples of text in all the colors shown on the color bar chart. For black and white 
printers, this will produce shades of gray in most cases. NOTE: If some of the colors 
print as black on color printers, change the Dithering setting in your Printer Driver, using
the Printer Setup command, or add a mark to the Print TrueType Fonts as Graphics in
Printer Setup.

Printer Setup—Use this command to alter printer settings or to change printers. You'll 
see the normal Windows Printer Setup dialog box for your printer. When you return to the
program, you'll be asked if you want to update your font list. If you changed printers, you
should answer Yes to avoid font conflicts.



Update Font List—Rockford! handles fonts very well, but there may be times when you 
need to relist your currently available fonts. This command does that. You probably will 
never need to use it, since the program rebuilds its font list, if necessary, each time it 
starts.

Exit—Quits Rockford! , with a confirmation box. Click [Yes] to save the current card and
exit. Click [No] to exit without saving. Click [Cancel] to return to Rockford! . If you've 
changed printer settings during your session, you'll be asked if you want to reset printer 
options.

EDIT MENU
Undo—Most commands in Rockford! which require more than a single click, can be 
undone with this Undo command. If you make a change, then decide to go back to a 
previous state, check this command. If it says Can't Undo, then change back manually. 
Otherwise, the command will tell you what will be undone.

Cut—Removes selected text from the editing box, then stores it in the clipboard. 

Copy—Sends a copy of selected text to the clipboard. 

Paste—Copies text from the Windows clipboard to the current cursor location. 

Insert Special Character—This new command pops up a grid showing all the special, 
foreign, and symbolic characters available in the currently selected font. Hold down the 
left mouse button over a character to see an enlarged view. Double-click on a character to
add it to the box at the top of the screen. When you click the Insert command, all 
characters in the box will be inserted at the current cursor location.

LAYOUT MENU
Rotate Current Line—Like the [Rotate] button, this command displays the text rotation
dialog box for the current line.

Show Grid—Like the [Grid] button, this overlays a grid on your WYSIWYG display. 
The grid disappears when you give the command again.

Horizontal Card Formats—Displays a menu of horizontal card formats. To select a card
format, click on the submenu item which matches the stock you're using, or choose one 
of the camera-ready options. The WYSIWYG display will change to match the selected 
format.

Vertical Card Formats—Displays a menu of verticall card formats. To select a card 
format, click on the submenu item which matches the stock you're using, or choose one 
of the camera-ready options. The WYSIWYG display will change to match the selected 
format.

Custom Card Formats—Rockford! can also create cards in other sizes than 2 x 3.5 



inches and on other paper sizes. Use the commands in this menu to create, save and load 
custom layouts. Commands you can use here are:

Show Current Format Settings—Displays the current card format dimensions in
inches. If you aren't happy with these settings, you can change them.

Create Custom Format—If you want to create a custom format, use this 
command. Answer the questions in the dialog boxes, measuring accurately. As with all 
measurments, you may use any measurement system you wish to specify values (see 
below).

Save Custom Format—Once you have a custom formal you like, use this 
command to store it on disk. Give the format a distinctive name, so you'll be able to load 
it again later when you want to design new cards. Note that this file stores only the 
dimensions of the layout, not the contents of the card. You needn't supply a file extension,
since Rockford! will add one automatically. 
NOTE: This feature is disabled in the shareware version of Rockford! Please 
Register!

Load Custom Format—This command lets you load a saved custom format. 
Two custom formats are included with the program, designed to print on the folding card 
stock sold by Paper Direct and others. When using these, experiment on plain paper to 
establish the order of printing, etc., to get the effect you want on folding cards. Make 
notes on the order of printing to avoid confusion later.
NOTE: This feature is disabled in the shareware version of Rockford! Please 
Register!

Measurement Systems: Normally, you'll enter dimensions in inches (1.5, 2.33, etc.), but 
you can use any system of measurement by adding an abbreviation after the 
measurement. This is true any time Rockford! asks for measurements. The abbreviations 
are, mm for millimeters, cm for centimeters, pt for points and pi for picas. abbreviations 
can be in upper or lower case, but must follow the number, with or without a space. Valid
Examples: 2mm, .21 cm, 2PT, .5 PI

Margins—Sets left or top margins separately for text. Choose the appropriate 
subcommand. Small changes have big effects, so start with small margin measurements. 
The default is .1 inch. You may use any measurement system, as described below. 
NOTE: Margins affect only text, and can be overridden by either the Click to Position 
Text or Custom Alignment options. Use this command to set margins to compensate for 
pre-printed areas on cards or other stock.

Fudge Factors—This command displays a submenu you can use to alter the dimensions 
of your printouts slightly. Use it to compensate for slight differences between printers. In 
the submenu, select the option you want to change, then enter a value in the resulting 
dialog box. Both positive and negative numbers are allowed, and all measurements 
should be in decimal inches or in another system as described above. Measurements are 
added to or subtracted from the current settings. Use the Save Offsets as Defaults to 
make your changes the defaults, once you're satisfied. This way, you'll only have to 
perform these operations once for your printer, since the default offsets are loaded when 
the program runs.



NOTE: If you set incorrect fudge factors or change your printer, select the Delete Saved 
Offsets command under the Fudge Factors menu to remove all settings.

Left Align All Lines—Sets all lines on a card to the left margin. You can override this 
setting or any of the other All Lines settings, by using the Align list box.

Center All Lines—Centers all lines on the card. 

Right Align All Lines—Sets alignment for all lines to the right margin.

Insert Formatting Codes—The commands in this submenu insert special codes in your 
document which allow you to alter the appearance of just part of a line. Whenever 
possible, use the whole line formatting tools instead.

Normal—Inserts <Norm> in the line. This code returns the line to normal text.
Bold—Inserts <Bold> in the line, boldfacing the following text.
Ital—Inserts <Ital> in the line, italicizing the following text.
Underline—Inserts <Undr> in the line, underlining the following text.
Superscript—Inserts <Supr> in the line, superscripting the following text.
Subscript—Inserts <Subs> in the line, subscripting the following text.

NOTE: You cannot use inserted codes in Rotated Text or in lines which have their 
alignment set to Centered, Right-Aligned, or Split at Tilde. This would cause 
misalignments.

CLIP ART MENU
Insert Clip Art File—Lets you choose clip art files, just as with the [AddArt] button.

Position Current Image—With either the PIC1 or PIC2 option buttons selected, this 
command will allow you to specify a precise position for either clip art images. When 
prompted, enter dimensions in any measurement system, as described elsewhere in this 
manual.

Edit Current Picture—Starts Windows PaintBrush and loads the picture selected with 
the option buttons for editing. When you exit PaintBrush, you'll return to Rockford! . To 
use the altered image, delete the current image, then use [AddArt] to reload the image 
from disk.

OPTIONS MENU
Make Current Font Name Default—This command sets the current font, as highlighted
in the font menu, as the default for all blank lines in your card. It's best to use this 
command before entering any text.

Make Current Font Size Default—As above, but sets the current font size as the default
for blank lines in your card.



Save Default Settings—Stores the Font, Size and card size and layout settings made 
earlier in a file which is loaded each time Rockford! runs. Use this command if you want 
to save these settings for use in most cards.

Delete Default Settings—Deletes the default settings file. Use this command if you want
to make a permanent change in your default settings.

HELP MENU
Help with Rockford!  <F1>—This command opens a new window. On the left is an 
index of topics. To get help on a topic, just click on the topic's name. You can scroll 
through the list or type the first letter of your topic. Once the program finds the topic, the 
index name will appear at the top of the screen to the right, with the help information 
below. In some cases, a topic will have more than one entry. 

About—Displays information about Rockford! , including the current version number 
and support information.

OsoSoft Program Information—OsoSoft offers several other programs which may 
interest you. This command displays a window that lets you learn about these other 
programs and lets you order OsoSoft products. To view information on a program, click 
the [Info] button next to that program's name. To order, enter the quantity desired for each
product. Then fill out your name and address information and mark the appropriate disk 
size box with an X. Click the [Print] button to print the form or the [Cancel] button to 
return to Rockford! .

NOTE: You can always order OsoSoft products with your Visa or MasterCard as well. 
Just call (805) 528-1759 to order.

EDITING YOUR DESIGNS
Editing Text
The easiest way to replace existing text with new text is to highlight existing text by 
dragging over it with the mouse, one line at a time. Once the text is highlighted, just type 
your new text, which will automatically replace the highlighted text.

Controlling Line Spacing
To make fine changes in the spacing between lines of text, make sure there's at least one 
blank line between the lines you want to change. Then, position the cursor on a blank line
and change the font size for that line. When you update the display, you'll see the changes
on your screen. You can make changes in 1-point (1/72") intervals. If you need a font size
smaller or large than those offered in the font size list, simply type it in the display area of
the list. Rockford! does not accept fractional font sizes.

Placing Text Beside Clip Art
You'll often want to position text next to or around clip art images. To do this, use the 
[Alignment] options or the Click to Position Text check box.. For example, to position 
text to the right of an image, choose the Right Aligned alignment option, then add spaces



after the text to move it to the position you want. Similarly, use the Left Aligned option 
to position text to the left of an image. This time, however, place your spaces to the left of
the text. To wrap text on both sides of an image, insert a tilde (~) where you want the text 
to break, then choose the Split at Tilde alignment option. Once again, pad the text with 
spaces to achieve the position you need. Don't forget the Custom Alignment and Click 
to Move Text options for even more precise positioning of lines.

Overlaying Graphics with Text
You can print text on top of clip art graphics, but this text may be partially obscured on 
the screen. To see text which will overlay a clip art image, click the [HideArt] button. A 
dotted box will appear to show where the graphic is located. Use overlaid text with 
caution, since it may obscure part of a clip art image. HINT: Try using a contrasting 
color for text which overlays a graphic.

Working with Split Lines
Rockford! 's ability to split lines is very powerful, letting you position blocks of text on 
both sides of the card. Normally, the left half of the line is flush with the left margin, 
while the right half is right-aligned. Often, however, you'll want to center blocks of text 
or manipulate the alignment in other ways. As described above, use spaces to pad the text
until it's aligned just the way you want. 

Creating Columns in Rockford! 
It's easy to create columns for text. To do this, select a custom alignment or use the Click 
to Move Text command for the first line in the column, positioning it exactly where you 
want it to appear on your card. Then, either enter new  text on subsequent lines or click 
the [Dupe Prev] button on subsequent lines. All lines will line up with the first line. TIP: 
When creating columns of text, it's best to place this text at the bottom of the text in the 
text window. This helps prevent misalignments of other text.

Working With Rotated Text
If you want to use rotated text on a card, it's best to add the text to the bottom of the text 
box text. This helps prevent misalignments of other text on the card. Before typing the 
text to be rotated, click the Click to Move Text check box, then click in the WYSIWYG 
window where you want the top left of the text to appear. Then type the text and click 
[Update]. You can use the Click to Move Text as often as you like to get just the right 
positioning.

Printing Samples
When working with complex card designs, it's a good idea to print occasional samples of 
your design for checking. After printing a sample, you can make changes to correct slight
misalignments. For speed, use the Print Single Test Card command.  REMEMBER: 
This sample card prints in the top left location on the card stock you're using. Use this 
command to check alignment if you're using Fudge Factors.

Rockford! TIPS 



Printing
Printing takes time. Rockford! and Windows have to compose graphical pages 

before a page emerges. You'll need a little patience. If you're printing sheets of cards for 
instant use, you'll get the best results by printing a sheet on good quality card stock.  Use 
the multiple copy feature in the Print routine to specify more than one copy. HINT: 
Remember to set your printer's options in the Windows Control Panel's Printer Setup 
screen BEFORE starting Rockford! 

For maximum quality when printing Rockford! card designs, be sure your laser 
printer has a good toner cartridge. If you can set print density, choose a medium or dense 
setting to achieve dark blacks for reproduction. 

Rockford! can handle color clip art images, but the final output will depend on 
how your printer interprets the colors in your clip art.  HINT: If some colors print as 
black on a color printer, change that printer's dithering settings in the Printer Setup 
dialog box. You may have to click Options  in the dialog box to get to these settings.

Notes for HP DeskJet Users
DeskJet printers may set their ZERO point differently than most printers. You 

may have to set Fudge Factors to get proper alignment with standard card sheets. Print a 
sample sheet of cards with text in the upper left corner,  then set Fudge Factors to 
compensate for misalignment. When your cards are properly aligned save your Fudge 
Factors as the defaults and you'll be able to ignore these items from then on.

Watch your bottom margins. On some card formats, text too close to the bottom 
of a card may cause the printer to eject pages rather than printing the last row of cards.
Try setting the paper size to Legal if your printer ejects pages and doesn't print the 
bottom row of cards.

DeskJet color printers may print some of the colors as black if Dithering is set to 
Standard. To fix this, set the printer for any other Dithering type in the Options section 
of the Printer Setup dialog box.

REMEMBER: Load card sheets face down in your DeskJet's paper tray!

Working With Clip Art Images
Rockford! accepts .BMP, .WMF and .PCX graphics files. Graphics programs, 

such as Windows Paintbrush, supplied with Windows 3.x, can create these files. You can 
convert other file types, using any of a number of format conversion programs, such as 
HIJAAK, Publisher's PaintBrush, and others. 

The size of your image is important. Art for cards is quite small, almost never 
exceeding 1" in any dimension. While Rockford! can handle much larger images, it's 
usually better to scale large images in a program specifically designed to do that. 
Windows Paintbrush can handle preliminary scaling quite well. If you have a scanner, 
you can create your own clip art in minutes. Simply scan the image, then use your 
scanner software to produce a .BMP, .WMF or .PCX file approximately 300 pixels in 
each dimension. Naturally, tall narrow images will use other dimensions, but you get the 
idea. 

You can also create clip art images with any paint program that can 
produce .BMP, .WMF or .PCX files. Creating custom logos isn't difficult at all. Also, a 



number of clip art libraries are available, both commercially and as shareware. Often, 
however, these images may need conversion to a supported format or scaling. You'll also 
find interesting clip art files on the OsoSoft BBS.

Clip Art Tips

Very thin lines often don't print well.

Large black areas may present problems for your laser printer, and sometimes don't 
reproduce as completely black.

Reducing a large image to card logo size often results in loss of detail.

Increasing the size of tiny images usually results in jagged lines on your printout.

Lines, Boxes, and Circles
You cannot draw a graphical element that extends into a clip art image. The line 

will end at the edge of the image. You can, however, overwrite text with a line graphic. 
Let the WYSIWYG display be your guide. Be careful not to let lines, boxes, or circles 
extend past the card's borders. Always check the WYSIWYG display for conflicts.

Use the [Update] button to see the results of your changes. As you draw and 
move lines, text may not appear if it has been overwritten. Update to see the actual 
image.
Draw with different colors to create special effects. Combining thick lines with 
intersecting white lines can create interesting effects. You can create quite complex 
drawings using the line drawing tools alone, including simple logos.

You can also draw boxes or circles, with fills, around existing text on your design.
It's best to first create the text, then follow up with lines, boxes, and circles. Use the 
positioning scroll bars for precise sizing and placement.

Try using a filled box or circle to set off text. Use a light color with black or dark 
colored text or a dark color combined with white text for special effects.
Overlaying white text on a black filled box is the best way to create reversed text. The 
Reverse command included with the program is primarily there for compatibility with 
previous versions, but is not as good a way to create reversed text as a filled box.

Precut Card Stock Suppliers
Rockford! now supports  precut and preprinted card stock from all suppliers. This stock 
feeds cleanly through your printer, and is the very best way to get professional-looking 
business cards from this program. Call any of the numbers below for a catalog of card 
stock suitable for this program:

Company Phone
Paper Direct 1-800-APAPERS
BeaverPrints 1-800-9BEAVER
KMAK Industries 1-203-239-3372
Premier Papers 1-800-843-0414



Viking Office Products 1-800-421-1222

TROUBLESHOOTING
Setup Doesn't Work—You may have older versions of some of the files needed by 
Rockford! installed in incorrect directories. Load README.WRI into Windows Write 
and use the manual installation procedures described there.

Reversed Printing and Shaded Text Don't Print Correctly—Change your printer 
settings with the Printer Setup command to enable the Print True Type Fonts as 
Graphics check box.

Clip Art Images Don't Print—Exit Rockford! , then run Windows Setup from the icon in
Program Manager. Change to a graphics driver which displays 256 colors or less. Some 
high-color display drivers are incompatible with Rockford! 's graphics printing methods.

A Thin Line Prints on the Right Side of Clip Art Images—With some video cards and 
printers, this may occur if you display 256 colors or more. This is a flaw in the video or 
printer driver. Switch to a 16-color mode to eliminate the problem until you can obtain 
improved drivers.

Cards Print in The Wrong Place on The Sheet—Use the Fudge Factors command in 
the Layout menu to adjust Rockford! for your printer.

Only 9 Cards Print, Then My Printer Ejects a Page—See the section of this manual 
on DeskJet printers, and try setting the printer for Legal Sized paper.

Small Fonts Appear Incorrectly in the WYSIWYG Display—Due to the way 
Windows handles TrueType fonts smaller than 8.75 points, your WYSIWYG display may 
not display these fonts correctly in small sizes. They will print correctly, however. 

Some Colors Print as Black on My DeskJet Printer—To print all the possible colors, 
you need to reset the Dithering Setting in Printer Setup. 

Rotated Text Messes Up My Layout—To prevent this, enter text to be rotated at the 
bottom of the text in the text editing window, then position it with the Custom 
Alignment or Click to Move Text options, then rotate it. Alignment of text below the 
rotated text is affected by the rotated text.

I Can't Figure Out What All the Buttons Do—To get Title Bar help on any button and 
on most other items on the screen, click on the item with the right mouse button. 

I Get an Error When I Print Cards With Graphics—Your graphic files may be too 
large or you may not have enough free hard disk space for the TMP files created by Print 
Manager. Try scaling the graphics in another program or turn off Print Manager in the 
Printer section of the Control Panel. Also, your printer may not have enough memory to 



handle a full page of graphics.

When I Load a Card from Disk, Graphics are Missing—This can be caused by two 
things, both of which are easy to fix: 
1. The graphic file is no longer in the same place on your hard disk. Rockford! does not 
store the graphic itself in the CAR file. You'll see a dialog box if this happens.
2. You're an international user and you're using European numeric notation. See the note 
at the beginning of this manual for more information.

I'm in Another Country, and the Paper Sizes You Use Are Not Available—Rockford! 
can print cards in other sizes and on other sizes of paper. See the Custom Card Formats 
and Sizes command in the Layout menu to configure your custom sizes.

I Prefer to Use Metric Measurements When Creating Cards—That's no problem. 
Anywhere the program asks you for a measurement, give the dimensions in any system 
you want, then follow the number by an abbreviation for the scale. For example: mm for 
millimeters, or cm for centimeters. No space is required between the number and the 
abbreviation, but you may include one if you wish. Other abbreviations you may use are: 
pi for picas or pt for points.


